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Creating a Top Hat account

Step 1:

Click on your individual link we sentto your email.
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Step 3:

TOP HAT

Q@ 0 = o i

lain Acrani Coading Thogrwe Finickusd

Create your account

Enter your school email address

Emuil Rogpsin

| ~chaodl cmmall recommiEnoe:

1 agree to the Tenms of Scrvkoe and Frivacy Palicy,

Enter the email you
used to register for the
examination.




Step 4.

TOP HAT

& B0 %

@i Asoaunt Crading Shoerwe  Fipiskwed

Create your account

A verification email has been sent to the email
address you entered. Please check your email to
continue with the signup process.

{11 Didn't receive an email?
Pleasn check your spam falder Yau can also try again ar

CHMBCLSUpPRGIT al 5y '.'-:'I'i.!"i'l A G,

Follow the instructions
by going to your email.




Step 5:

TOP HAT

QO 6 = o

Join Account  Grading Phone  Finished

Create your account

Enter a few details below to create an account.

First Name (Required)  Last Name (Required)

‘ Enter your first name ’ ‘ Enter your last name ’

Password (Required)

Please enter at least 8 characters ’

Show password

» Between 8 to 100 characters long

« Strong passwords are hard to guess and don’t contain common
words or identifiers like your name, email, or school

Fill in the following
information.




Step 6:

TOP HAT

Q00 ¢ -«

Join Account  Grading Phone  Finished

Enter your student ID

Enter your official school student ID to ensure
your answers and grades in Top Hat are
properly applied in your school’s system.

Student ID (Optional)

‘ Use your school’s official student ID ’

Skip

You can add a student ID Later under your settings

Put your CTFNno here.
The number starts with
05




Step /:

TOP HAT

0 00 -

Join Account  Grading Phone  Finished

Add a mobile phone

Add a mobile phone to submit answers with
(SMS) text messages

Mobile Phone Number (Optional)

‘ Enter your phone number ’

You will be sent a 4-digit verification code to confirm your
number. Your number will always be kept private.

Skip

You can still participate with your laptop, or with the Top Hat
mobile apps for iPhone or Android.

® Please Note

If an existing phone number is added to a new account
it will be automatically removed from the old account.
Please read your verification text message carefully for
more details.

Press “Skip”




TOP HAT

0 00 -

Join Account  Grading Phone  Finished

Your account is set up

Use this account to access Top Hat from any
device you want! Desktop (browser) oriPhone,
or Android apps.

Press “Continue”




Your account is now set-up.

You are now able to take trial examinations.



If you created a Top
Hat account In
previous years

Step 1:

Click on your individual link we sentto your email.



Step 2:

u g

TOP HAT

Log in to access this course
CDECB 2023 - C- PDT - Sat, May 27, 2023

School

Canadian Diabetes Educator Centification B G

Email

LR

Password

-

Forpal password?

Don't have an account yet? Create one

Enter the email and password you
used when you created your
previous CDECB Top Hat account.
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Logging into a Top Hat

account

Step 1:

Click on your individual link we sentto your email.



Step 2.

™

TOP HAT

Log in to Top Hat

Welcome back! Please log in below

School

e

[ Canadian Diabetes Educator Certificati Q ‘

Email

i } ' | i)

Password

EForgol password?

Don't have an account yet? Create one

Enter the email and password you
used when you created your
CDECB Top Hat account.

15



How to find the
examination

Step 1.

Log Into your account



Courses |/ CDECB 2023 -C - PDT - Sat, May 27, 2023

. , Make sure you are on the Bca s
Clas Assigned .
: “Assigned Tab”

E} Sample Examination2 -8 n
Start Test

@. FAQ's about writing the Examination Details

‘ T . ) available from April 24th at 2:11 pm till May 26th at 11:59 pm

1 PERGAESS « Ends May 76, 11:55 P

& Timer set to 8 minutes,

@

Sample Examination 3 - 165 Questions © You must start this test before May 26th at 11:51 pm for the full 8 minutes.

7% Whiteboard available in test
Sample Examination 4 - 165 Questions

@

@ Thisis a monitored test. Please ensure you follow the do's and dont’s.

le Examination 5 - 165 Questions B Allanswers will be auto-saved.

®

Sample Examination 6 - 165 Questi
%1;. amina h - 165 Questions

Do Don't

v Try to answer all questions before handing in X Exit the test window until you've handed in

your test
v Allow access to your microphone

v’ Allow access to your webcam

All Examinations (Trial or CDE
examination) will show up here.
When completed they disappear.




Trial Examinations ¥:

These examinations are intended to familiarize yourself with the examination platform.

«

You are not required to complete all 6 trial examinations.

You are not required to complete all of the questions within the examinations.

We recommend you work through the following examinations:

1 1t examination to familiarizer yourself with the tools. (approx. 5-10 minutes — depending upon
how long you take.)

[ 279 examination to familiarize yourself with what happens if you run out of time. (approx. 10
minutes)

[ 3" examination to ensure your computer is capable of downloading a 165 question examination
at the location you plan to be. Be sure to use the same computer you plan to use on the
examination date. (approx. 5-10 minutes — depending upon how long you take.)

[ 4th - 6th examination are extra exams for those who wish to practice more.
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Not Set-up for Proctorio

Are you using a Chrome browser?
This is a requirement.

«

Step 1.

You are not set up to access this test

You must use Chrome, and have the Proctorio browser extension installed to access this test! After
completing the following instruction please refresh the page.

Click on “Get

v You're using chrome. Great work! .
Proctorio

¥ You don't have Proctorio's Chrome Extension Get Proctorio

19



Step 2.

¢~ chrome web store N £ Ssignin

Home > Extensions » Proctorio

Proctori

Offered by: proctorio.com

* 3 1,925 | Accessibility | & 2,000,000+ users

Click “Add to Chrome”

20



Note: You can delete the extension

St e p 3 : after the examination is complete.

X
i1} : II‘?
chrome web store @ Acd “Proctario™

It can:

Home > Extensions > Proctorio Read and change all your data on the websites you visit

Display notifications

g Modify data you copy and paste
PrOCtorIO Capture content of your screen m

Offered by: proctorio.com Manage your downloads
% 3 1925 | Aecoosl Identify and eject storage devices
Cancel Add extension
Overview Reviews Support Related

Click “Add extension”

21



Ste 4 . After this shows up you can close
* the tab.

~ chrome web store

(.) Proctorio has been added to Chrome

This icon will be visible when the extension can
act on the current page.

Home > Extensions » Proctorio
Manage your extensions by clicking Extensions in

the Window menu.

Proctorio
To get your extensions on all your computers, turn on
Offered by: proctorio.com sync
Turn on sync...

T Introductory Psychology - PSY X & Proctorio - Chrome Web Store X +

) @ chrome.google.com/webstore/detai fpmapakogndmenjcfoajifaaonnkpkei/related

web store

> Extensions > Proctorio

Proctori

Offered by: proctorio.com

Press the X to close the tab.

* i - #r 1,925 | Accessibility | & 2,000,000+ users

22



Step 6:

é

X

L

T Introductory Ps:

T x

Introductory Psychology - PSY100EH1

Join Code: 810805

CLASSROOM

All Items =

Test Bank

1item

-

PSY100 Exam
Test in Progress

ASSIGNED GRADEBOOK

Unanswered

# app.tophat.com/e/810805/assigned

<

Press the refresh button or
press “F5” button on your

keyboard.

PSY100 Exam

You are not set up to access this test

You must use Chrome, and have the Proctorio browser extension installed to access this test! After
completing the following instruction please refresh the page.

+ You're using chrome. Great work!

¥ You don't have Proctorio's Chrome Extension Get Proctorio

23



Taking the examination

Step 1:
Log into your account on Chrome

©



POT-Swt Mu, % |
> C i spp-catophat.oom/e/B!

52 [ ardagng

Courses | COECE 2023 - C - PDT - Sat, May

b

Faf's about writing the Examination

O ww My JA, LESY Py

Samnpln | ansiration 3 8 mbmle Dmer

B FERSEERE - Doy My 20 P15 P

%I Sample Exsmination 1 - 165 Questions

™ FRE Rl i

EJ" Sample Exambnatisn 4 - 165 Questions

%} Sample Examination § - 165 Queathons

n.__} Sammple Fxamirglion & - 6% Questlons

Find the examination you plan to

Dlails

) Aovablabla frem April 241k 52 2211 pm 0 May 26t 5 1 1:50 pr

‘ﬁ Timeir st 20§ mlnuted

0 Veru Mt start thiz bean belore May 26th a2 11:51 pr for the full & mingtes,

3 Whitetoard available s bes
ﬂ This s & monitoced best. Pleass eniee you Fllow the do's and dent's

B 48 anzwers will ba auto-zaved,

Do

o Ty to answer all

seatisnd belore handing i
o Al a00ess 1o your microphans

v Alboey BCCERS 10 yogir wabtan

Click on “Start Test”



Step 3:

tnations page x +

w = 0 w
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Ca proctorio

Before you Begin

This page tells you what
information is collected.
You need to scroll down to the
bottom of the page.

This eotam will be proctorod. Homa are  fow things te knaw bafore you bogin,

We will tell you when we Your institution can access Decisions are made by
start and stop recording. the data collected and will your exam admin, not us., |
contrel who sees it. f

Prociceie dow, complies with GOPR. FERP. and ot repulstons. Resd sw Prbvicy Pofoy
Yeuur dlarka will bar securely stored in Guebee City, Guabec for & months Belore Boing delobed

What's recorded during the sxam
|" camara feed = mplio sCompaior Soroon » omam oavirenment Jwobsdlos
visited «lacation « identity document

What's restricted during the exam li

E afw maniled «lull-scroen mode «no new Wbs «no dipbaard =no printing «
no dovwnloads

24/T support avallable during the exam
Click: thi Proctorla browser axtension icon 1o chat with an ogent within
SeCOnch.

B G et pags - G




Step 3 continued:

W (u ] »

MEBIHGWE. 2 o o O @

&' Inanctions page x |BE
€ 3 C i getproctonocom/id6036450TT 064206 A BED 4ol i
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This ecam will be proctored. Hore ano a fiw things to know before you begin,

We will tell you when we Your institution can access Decisions are made by
start and stop recording. the data collected and will your exam admin, not us. !
control who sees it. | |
Prociario dae, complies with GRPR. FERPA. snd clhet requiations. Read our Privacy Pedey i
Your data will b securely sicred i Queber Clty, Quebec for § manths belore iy et |
|
What's recorded during the exam |
Amera Toed « madio «COMPULET SCroon - BXam onvifonment swobsitos |
wistted < lacation < identity document i
: |
|

What's restricted during the cxam

one manitor «lull-screen made «no naw tabs «ne clipboard «no pr

no downioads

24/7 support avallable during the exam o . V)
Press “Continue

Click the Proctorio browser extonsion kcon to chat with an agant within
seconds.

Acceiaibility options:

Enabie high visiiny modo.
Lentn more about Prociorio’s approach to Accessibility

Yoruar cocoemy hasn't starbod yot! First, wo nood to sot up your systom 4 m
l




Step 4.

& proctorio

System Diagnostics Test

The system diagnostics test will anly take a momant

g o

Wobcom Microphone Connection Desktop

This page is going to compete a
system diagnostic test. If you
experience issues with completing
this find the “How to” page on
® " m e — r S— suggestions to fix the issue.




Step S5A:

IS BRI D30 DM G 7B E O (T L aTB T il GHy TR NN eaL D A5 E0EnPL M IUTH AP Pl TIE0E R EC Tepheh sz

SNFVINIMS BT, 2 & O @
& proctorio

Click on the picture of your

System Diagnostics Test screen.
i If you have not clicked the share

button is unclickable.

Frectono wants b0 share the contents of your iereen

e
[ "
S

Click on “share”




You need to press “Allow” for both
Camera and Mircrophone.

aed Sy Cuageanen Tl Pags X +

/A These permissions must be allowed.
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Step 6:

3 TestPac @ x +

Al o} B gelproctano.comyTd60364 SndT 0642 ACHREE Ay Dol a2 81 DymeiMESORI0S 0Dy A EOE ] hedT 1] GHY TN CEIGAPOM. 2 PAET 3ol P bt 3 M LT - H
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E ! heMp FelgVENINMS2 B2 H = g

@ proctorio

System Diagnostics Test

Initial system checks passed

Your exam is about to begin.

% Use Restroom,
M Gotwatoe,

it} Gat comify.

P Click on “next” once you are ready
Donl see voursell above? Click Heve, to begin the exam-

H
o
a
&

.1
&
4

_..5'-: Coudy @7 s EHGJ w1 a®
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@ proctorio
Webcam Image Test
o ety & wrkdn oty lss ok o o vl . cotre, and oy You should be able to see yourself.
visible.
CI H k o" b H ”
ICK ON €egin Camera test
Don't see yoursell above? Click Hete,
Iy

- - @ Wibcem Image Tet

g i . MR ECCouy @7 EHe w qnapn




Step &: ),
P %

e o x +
€ C ProCts = 5 %
PrOCodi.com, 2 '} Dpol S F ST Dime MBS 3 O = LT t
R Dpol e F T Dyma MBS 3 D% DR 2 OO ¥y G 7B A ED Tha] TyvLaTb T AeitGHYZF SN osal 0185605 POM IUTY 2P QP aET 36036 % S FbbwEAC coheiivasss T = w & 0 e .

®_  proctorio

Webcam Image Test You should be able to see yourself.

Wa ara taking 5 sample pictures, please look diractly into the webcam and smie!

These are the pictures used to
identify you against your
identification.

Nothing is required by you at this
step but to look at the camera.

[ =i b G Wiebscamn Image Test i Procionio i sk bl r - l.: _ B iCCosy @7 s EHGS WO BB “:JI_':':::.'.':..' =)
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Step 9:

5 ldemity Vesficaton Test Pog. @ 3¢ -+

- 3 O 8 gelproctono.com/Tab0364501Td64 2ahboc2 4 TR VB Do AT Dy MO0 % 3 DR D 0N GT O ihakl 1 Vb7 hitGHyZF 185645 POM I TS8P PaET 36008 2 FwwiiSC T cohabibmoir K 2F eh gV N InhES2 8 f zHix - ;
7 toro 3645017 A6 226boc 2 A0MSBERE ol cTRICVD XU ) ¥ s
Dpolia®araTDymejMSBO%3I0% D% 2C0Im0 G BadEOz TH VL a T b TRt GHYZF NE oAl 01 5B En PO U TS I8P PaE T 360E %2 i S0 T cohal bnicar .25 MgVENIrh 2R * 0 .‘

® proctorio

Identification Card
Hold up your photo identification.

Not completing this step can
result in disqualification.

Shew a phato 1D 1o the camera within the aroa indicated. This will bo usad 10 valldata your identity. Iif this is
umsuccassiul a Bnk will appoar, Simply click the link 1o manually scan o phote of your 10

My g

TN AT T

sscanned automatically.
L —

Having irouble? Bead This Article
Denl see yourself above? Click Here,

A Fip Horlzontally? L

34



Step

oy @ X

o 8 getproctono.cn

& proctorio

+

TG0 364501

T

abbec2A0TRBES e cI I O

B T BN DT T A e A P L L § P E14) 1
bX Dol a2 aT Dpme) M SBO% 3D IDRIC ..ﬁ-.*..!!',r‘-a.dr_n,;'hns(‘1,—;.|;.|,,|\+.,rcp_ﬂ:rq_l.-m;_\l_{}ngg,gz&.p;\_:m TR 2P fPal T IS %2 N 30 TeoheNarse % 2 e MgV Inb%62 812t

Identification Card

By clicking naxt, you agrea the imagae of the identification cared disployad can bo USed 10 werify your
Idontity,

Hawving rouble? Bead This Articls

Press “Re-take” if your photo ID is
not clear.
Press “Next” if it is clear.
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@ proctorio

Desk Scan

your camara will be usod 16 scan your desk snvironment.

This page is preparing you to do
your room and desk scan.
Press “l understand”

Your institution requines you to scan your environment. The request for a scan will inchsde spacific
instructions aboul what area 1o scan. You can find more detalls hore, The scan may | & & 360 view of
tha ontite arca, 8 view of the ceiling o laor, & view of the area under your desk. a view of the items on your
desk, of some combination of these things. If thera ara tems in any of thoso arcas that you o not want 1o
be recordad, ploase take o MomEnt now 1o cover them or remove thoso Rems, or move 10 8 @iferent area.

Somaotimes this can be tricky. especially whin using o builtin webcam, Boforo ONnGg On, W Fecammend
you visit the help center article.

I understand » D
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Step 12:

Exam Agreemenn Page w® x| 4

v
g L TP OCtond. FTe603545) 42a6boc? A0MSBAA -, BX Mool k% 7F RSB 3 OV Ty S 4 8s ] o LAl ]
€ c etpeactoni.com, Tab03E o 2 abiboc 208638 cdcy X ROpOU SR T DymaME S0y A35\--]<-.C.|'-5."'Jl"3,*--‘U'\1I:u.r'-h"55f'I-.'-'--Ilhr-‘»\nlﬂ!i;‘?‘f‘-‘ll{nwlﬂ1E.\&[éa?{'.‘—‘-i'_'["é?ﬁ?.}!r—‘a."-'!ﬁ-r&ﬁ-zfu\.Hn.1].‘.\’,"cc-':'_\'-r-'x'.. MgVINInME2B1zHe. ™ w2 & » O @

Ca proctorio

Exam Agreement

Press “l accept, begin exam now”

By clicking I accept” | represent and warrant thal [, Jossica Slovens, am porson whose name is
assoclated with the login used iy this sssessment Systom. | futher coctify that | am the person wiose name
appoars oft the identification presented snd that said identiication is legible in the image shown, |
Lirrdiorstand the profibited actions and code of conduct as described in the appiicabie policy of
Insifiution. If cver the age of 18, | acknowsedge thal | have read and agree fo the Torms of Sendce, and 1o
the Privacy Policy . i under the age of 18, | undorstand that when my parent or legal U cian frovidod
consent o the Instifution for my sccess to the Services, they consontod to the same terms and privacy
policy: If  or my pavent or legal guardian have any questions, wo will contact Proclora befono elic #ing 7
ncm.'p.!'n\rarm‘;a using the Sovvicos,

Your exam administrator fas enatied & calculator on your axam with ClassCale. Plpase review el Terms
of Service boere,

B D Y P G Euam Ageeement Fag

Q_Ciﬂmﬁn1:-1l3.i.'d-r'... L Be B
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Presz | F11 | to exit full screen

waiting for app-ca.tophat.com...

The examination is loading.




Step 14:

Press “Start scan”
Then complete the room scan.

Sorry for the interruption...

I'Te ready, please click start scan.

39



Step 14:

Finish the room scan. Once
complete and you are happy with
it press “I’'m done, continue.”
You can continue to complete the
room scan even if the “I’'m done”

appears.

Please Complete the Scan

40



Your examination is now on the screen.



Examination Tools

J Whiteboard
[ Calculator
L Time remaining

L Flagging of Questions
[ Chat




Whiteboard

| Your Video
recording
here
E E st 4
E vens, Jeusica 2100 1 d ol

; |
s bor the Top Hat Testing Platfor.. (2} All your arwers will automatieih ssus 3 e nencsad Hel
G} GQueestion 1 5 = I g o
v v
L) ETI e )

®
[l * e
ap
R

®

@ Questic
/ Hhelio | am trying out the whiteboard)
Question § (4]
oo § O

Whiteboard
@ 4 (s] |
\ .I'

raestion 15 5] I

ik
Quesstion 16 o} [ | i
paestion 17 (o] 1‘ @ |
! 13

You are able to type using the “T”
" — button or draw with the pencil.

@@@@9@@@@9@@@@@@@

Click on the picture of the
whiteboard to have it pop up.




Your Video
recording

here

Calculator

o o © H£ B
2113

- -
%
7
4
[ we |
@ e
@
@
@
@
@ o

The Calculator shows up on the
left side.

Click on the picture of the
calculator to have it pop up.




() Time Remaining: 59m 43s  Hide

5o, DS gt AT oty b Blect B s

Time Remaining is at the top.

If it “disappears” it just means you
have to use the outside scrolling
to scroll to the top of the page.

This happens because your

browser zoom is larger than 100%

() Time Remaining: 59m43s Hide



F (]
gg l g /
Notice the Flag to return to the <

question

«

Unanswered
guestion

th t Testing Platfor,., g " i
g @ .&-.-,o..r:.:-.v.r:r-,w.!1.:.-,om.1l.u':,.-uw-nym,p:oc.tm-,hwgmm:s‘:_ I

Click on the Flag so you know to
come back to that question.

roed, For kayboasd prgstion, press opthown 5570w ki 1o seled s ang m T ]
i @ question? !o ! |

@ Questions o
@) questiona E
) Pestion10 d

i Question 11
&) question12

@ Question 13

Q o

e (T 1o £ B 1 o Jet W T o o B o o e

Answered
question




Chat

Click on the chat within the examination to speak
with a representative who can help with the
examination program.

OR
Telephone our office.
1-905-838-4898 we may be able to help you.

Your Video

recording
here

Click to chat




Errors

U Browser Tab

U Not enough RAM

J Stable Internet

J Webcam — Enabling

O Microphone — Enabling
J Desktop

L Multiple Screen

J Camera

] How to delete cookies/cashe 48




can continue, please do the following:

Click on the “click here” to close
the tabs you have open.




Not enough RAM Error: %

RAM is the short-term memory. How efficiently your computer works depends on the amount of
RAM you have. RAM allows your computer to multi-task.

If you experience this error you can try clearing your history on your computer and restarting your
computer. However, likely your computer is not capable of handling the administration of this examination.
We suggest you locate another computer and begin the process again. Very old computers likely will result

in this error.

Clear your history on your computer
* Tap the three dots in the top-right corner of the screen, hover over “More Tools” and then select “Clear browsing data”

* Check the boxes next to Browsing History, ---Cookies, and Cached Images and Files.

* Click Clear Data.
* Press F5 on keyboard to Refresh.



Hardware inefficiencies: %

CPU disk space is the general space you have available on your computer. The processor, also known
as the CPU, provides the instructions and processing power the computer needs to do its work.

Similar Error to this one.

If you experience this error you can try clearing your disk drive and performing a disk defragment. (This is
not a fast fix.)

It is recommended you find a more up to date computer with sufficient CPU disk space.



Stable internet error:

System Diagnostics Test

<
{00
\C'V

Thr systom diagnostics sost will ondy t

A stable internet connection

If possible, you should connect your computer directly to your router with an ethernet cable to ensure the most stable
connection. This diagnostic can take a few moments to run.

Free up internet usage within your exam location:

Unplug all internet using devises and disconnect any wireless. Ask other people in your home to refrain from using the
network (internet).

Examples: Smart TV, Cameras, Smart Lights, Google devises, Alexa’s, Gaming Systems, Internet Phones, iPad, tablets



Webcam error:

System Diagnostics Test
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Access to the computer’'s webcam has been enabled
You will see a pop-up in their browser prompting them to allow webcam access. You will not see this prompt if the
webcam requirement has been disabled.
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Microphone error: %

System Diagnostics Test

Thir systom diagnostics tost will only take a momoent

Access to the computer’s microphone has been enabled
You will see a pop-up in their browser prompting them to allow microphone access. You will not see this prompt if the
mircophone requirement has been disabled.
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Enabling Webcam/Microphone:

=> G ® Chrome

Settings

You and Google
Autofill

Privacy and security
Performance
Appearance

Search engine
Default browser

On startup

Languages
Downloads
Accessibility
System

Reset settings

Extensions [/

About Chrome

chrome://settings/privacy

I

Q, Search settings

By Your browser is managed by your organization

Safety check

0 Chrome can help keep you safe from data breaches, bad extensions, and more Check now

Privacy and security

= Clear browsing data
u Clear history, cookies, cache, and more

Cookies and other site data
Third-party cookies are blocked in Incognito mode

e Security
Safe Browsing (protection from dangerous sites) and other security settings

Site settings N
s
“"  Controls what information sites can use and show (location, camera, pop-ups, and more)
i Privacy Sandbox 0

Trial features are off

5 — ensure the microphone and camera are enabled
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e Y * 0O & F
New tab Ctrl+T
MNew window Ctrl+M
MNew Incognito window Ctrl+Shift+M
History
Downloads Ctrl+J
ookmarks
Zoom - 100%  + i
Print... Ctrl+P
Cast...
Find... Ctrl+F
More tools
Edit Cut Copy Paste
Settings
Help
Exit

B Managed by your organization
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Desktop error:

System Diagnostics Test

Thr systom diagnostics sost will ondy t

Screen recording has been enabled for the desktop screen
You will see a pop-up in their browser prompting you to select a screen to record. If the screen recording diagnostics
test fails despite following the instructions in the pop-up, you should make sure you have allowed permission for screen

recording with Google Chrome in your System Preferences (if using a Mac) or your Control Panel (if using a Windows
computer).
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1.Choose Apple menu > System Settings, then click

Privacy & Security in the sidebar. (You may need to scroll

down.)
2.Click Screen Recording.
3.Turn screen recording on or off for each app in the list.

Screen recording has been enabled for the desktop screen

You will see a pop-up in their browser prompting you to select a screen to record. If the screen recording
diagnostics test fails despite following the instructions in the pop-up, you should make sure you have allowed
permission for screen recording with Google Chrome in your System Preferences.
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Multiple screen error
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If you have multiple screens connected you need to disconnect so you only have one screen attached.
You are able to use a screen attached to a laptop however the setting must have the screens duplicated
(showing the same thing on both the laptop and the larger monitor.) A TV can be a larger monitor.

On a windows computer click on the “Start” menu, then “PC settings”, then “system”, then scroll down on
the display menu and ensure the multiple displays are set to “duplicate these displays”.



Camera error

webcam image 1est

' -orrectly. please make sure your face is well lit, centered, an
To verify your webcam is working correctly, please make sure your face is d, ¢

visible.

Your camera is not activate or the
lens cover is shut.

On a laptop there is a little cover
at the top of the screen that slides
to close it.

If this ever becomes closed during
the examination this is a reason to
be disqualified.

il_a_-_-l ts yourself above? ClICK Herd

i % s » C i SO your camera
Oh no! We're having a little trouble seeing you. Please adjust the camera b4 Begin

face is centered and clearly visible. Tip #208 Please do not cover your face with
your hands.




How to delete cookies/cashe

3: Clear browsing data 1: Click the 3 dots in top right corner

&« C ® Chrome | chrome://settings/privacy

@ Settings T

& Youand Google B vd /by your organization
History »

B  Auofill Safety check Downloads
Bookmarks »

@  Privacy and security ~ e

@  Chrome can help keep you saf| feaches, bad extensions, and more Zoom - 100% o+

(7 Performance Print... Ctrl+P
Cast.,

@  Appearance Privacy and security Find et Clear browsing data
Mare tools »

Q  Searchengine -

¢ —  Clear browsing data N Edit Cut Copy Paste Basic
B Default browser Clear history, cookies, cache, and more Settings —_—
) Help 4 Ti
() Onstartup & Cookies and other site data , ime range Last hour -
Third-party cookies are blocked in Incognito mode Exit
@ Languages o Security B2 Managed by your organization Browsing history
Safe Browsing (protection from dangerous sites) and other security settings ' ~lan + - o in 4

%  Downloads Clears history, including in the search box

oA bilit , Site settings

T Accessibiliy = Controls what information sites can use and show (location, camera, pop-ups, and more) ' . 2 Cookies and other site data

ICK O1T 4 cneckmarks S :
‘\ System O Vi Signs you out of most sites.
i Privacy Sandbox &
£)  Reset settings Trial features are off

Make Sure the time range is ChangEd Elic»:efl”:eages::n:;esﬁ Some sites may load more slowly on your next
to “all time” '
Then click Clear data

»

Extensions [}

About Chrome

®

2: Privacy and security




Preparing the Location you
plan to take the exam

= Remove the papers from your desk area. You should not have them
within reach or readability. If you do not remove the papers, you risk
being disqualified.

" Additional computers and electronic equipment powered on will cause
your disqualification.

= Cover any additional area with items difficult to move with blankets or

sheets. v
Q

= Take papers/diabetes related posters off walls/cork boards



Room scan

" Room scan may not be completed sufficiently if you are too quick. It
should take a minimum of 30 seconds to 1 minute to scan your room.

= Show us the ceiling, floor, the walls beside you, behind you, in front of
your computer and your desk space. Please make sure you are not in
front of the camera for the room scan. Use a mirror if this helps.

" Failure to scan everything we are asking for may result in
disqualification. TAKE YOUR TIME. We have added 5 minutes additional

time for the completion of the room scan.
Je
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Something has failed and /
cannot fix the problem

Telephone our office.
1-905-838-4898 we may be able to help you.

Getting your phone out to call us will not disqualify you.

We will record your name and the time you called us.
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